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Together with z/OS 1.8, IBM made available a tool named “WLM Service Definition Editor”.

It is a workstation-based tool that allows you to maintain your WLM service definitions using a
more user friendly interface than the classic, ISPF based, WLM Administrative Application.

Using this tool you can get many advantages in terms of visibility and manageability of WLM
definitions especially in complex, multi sysplex environments.

However it’s important to remember that this tool is not a standard IBM product, nor part of any
other one; it is a free tool provided “as is” without warranty of any kind.

In this paper the more interesting features of the tool are described together with our first
impressions and experiences using it.
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1 Overview

Managing WLM definitions using the classic ISPF based administrative interface has always been
a bit difficult especially when managing multi sysplex environments.

The major limitations of this interface are:

» A very limited visibility of the overall definitions structure due to the use of pop up menus;

» The use of key stroke selections, in some case inconsistent between different panels;

» The need to log on each sysplex to manage its specific definitions.

Finally IBM made available a workstation-based tool named “WLM Service Definition Editor”
(WSE in the following) which permits to maintain WLM service definitions using a much more
user friendly interface. Using this tool you can get many advantages in terms of visibility and
manageability of WLM definitions especially in complex, multi sysplex environments.

WSE can be downloaded, together with the user’s guide manual, at:
http:// www-03.ibm.com/servers/eserver/zseries/zos/wlm/tools/sdeditor.html

WSE integrates a transfer function that allows you to download/upload, using FTP, WLM service
definitions in ISPF format between host and workstation. This means, WSE does not interact
directly with the WLM component of the z/OS operating system, it solely operates on WLM
Service Definitions in ISPF format (see Figure 1).

WSE does not provide any support to extract, install, and activate z/OS WLM Service
Definitions'.

Service definitions edited with the WLM Service Definition Editor have to be in XML format.
The transfer function automatically converts XML service definitions into ISPF service definitions
and vice versa.

WSE WLM

WLM WLM
ISPF tables CDS file

Figure 1

The current version is WSE 1.1.0 and it supports all the versions from z/OS 1.4 up to z/OS 1.8%

"es important to remember that this tool is not a standard IBM product nor part of any other one; it is a free tool
provided “as is” without warranty of any kind.

2 you are running z/OS V1R4 or z/OS VIRS you need to install the IBM Communications Server PTF UK06395
(APAR PKO08856).
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2 Preparing to connect to z/OS

The fist step to do, before starting to download WLM Service Definitions from the host, is
defining an appropriate FTP profile using the FTP Profile option in the Options menu.
Figure 2 shows a sample FTP Profile definition.

Three different transfer modes are supported; if the configuration of the z/OS FTP server allows
the submission of batch jobs in JES you can use transfer mode 1 which provides a fully automatic
conversion between XML Service Definitions and ISPF Service Definitions.

To use transfer mode 1 the Script PDS field must not be specified.

FTP Profile: WLM PROD

Properties

Name L PROD
Hostname [PROD
Username |EF'VEIIZI1

Job Class |4,

Msqg Class |H

Accounting Info [958

Programmer Hame |Fabin Massimo Ottaviani

HLQ SBLS* [gvs
HLQ SISP* isp
Script PDS |
Codepage 1BM-037 B
Protocol F1P I~
Port |21 |

| Save ‘ | Cancel ‘

Figure 2

The second step is the definition of a FTP Connection, using the Transfer option in the File menu,
to establish a relation between the XML Service Definition file located on the workstation and an
ISPF Service Definition dataset located on a host.
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»© FTP Connections ﬂ
New Edit Copy Remove
Marme | LocalFile | Modification Date | Host DS | Action | Action Date | FTP Profile
FROD PRODMLM  File notfound 'SYST LM CNTL WM PROD
SPR1  SPERMLM | 200711009 14:458:38  'SYS1 MWLM CMNTL WL SPER
Open Download Upload Close
Figure 3

Clicking on the Edit button you can modify the settings to associate FTP Connections to FTP
Profiles.

FTP Connection: PROD x|

Properties

Name  |PROD| |

HostDS  |'SvS1.WLM.CNTL' |

Local File |PHOD.WLM H = |

FTP Profile |WLM PROD | - |

| Save H Cancel |

Figure 4

Otherwise you can click Download or Upload to start the communication with the host.

3 Downloading WLM definitions from z/OS

Once you created the FTP Connections and FTP Profiles for each sysplex, the first thing to do is
to download all the WLM Service Definitions to your workstation.

When you click the Download button a FTP communication is established between the
workstation and the selected host and a job is submitted on z/OS.
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As soon as the job ends all the produced sysout are sent back and analyzed by WSE. If any error
has occurred you’ll get a window including the “SPOOLFILE’ list.

spoolfiles x|

1. SPOOLFILE
2. 5POOLFILE
3. SPOOLFILE
4

. SPOOLFILE
. SPOOLFILE

Select Cancel

Figure 5

Clicking the Select button you can analyze the sysout as if you would be logged on z/OS.

The report in Figure 6 clearly states that the input file name was not correct. In fact instead of
reading the ‘SYS1.WLM.CNTL’ file, WSE tried to open ‘ESCO1.SYS1.WLM.CNTL’ which
doesn’t exist. We intentionally produced the error, for didactic purpose, by omitting quotes in the
FTP Connection settings.

5. SPOOLFILE

READY

FROFILE MOPREFIX
READY

ISPSTART CMDSPF ML ESCOT . 8YE1 MWLM CHTL ESCOT.5%51 WLM CRTL ML)
Carversion: ESCO1.8YS1 MWLM .CHMTL ESCO1.8v ST MWLM CHTL XML

*  Data setnotcataloged --ESCO1T.8Y31 MWLM CHNTL was not found in catalon.
READY
EMD

Figure 6
Based on our (short) experience we can say that the download process works well with no critical

issues to highlight.
We also downloaded WLM definitions from a system running z/OS 1.9 with no apparent problem.

4 Working with WSE

WSE provides three different views of a WLM Service Definition:
» Tree View

» Table View

» Print View

The first two views can be used to edit the Service Definition while the third is a read-only, ready-
to-print view.

The major benefits provided are:
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All the information is represented as tables
Direct manipulation of tables

Display of relations between policy elements
Real-time error checking

Context-sensitive help

Automatic problems check

YVVYVYYY

In Figure 7 a sample of Table View is presented.

WLM Service Definition Editor - C:\Programmi\WLM Service Definition Editor\SDSample.xml
File Edit Options Help

D] B [-] ]
E Application Emaronments | Scheduling Erir [ Resources | Service Parameter |
Resource Groups r Repaort Classes Classifications r Classification Groups |
Service Definition r Sendace Policies |/ Workloads and Senice Classes |_
Workload  |Service Class. |Per. Goal Im...| Duration |Respons. |Per.llev. |Resource Gro. |CP.. Cescription Modiﬁcat..JModiﬂcatmn U
WELDASC 3 ALL APPC Trimsaction Prograrsimes 105306 Gt bl
WELDASC Y asvmosTo Y BEATCHIN0 Mo | ASCH defuult Service Class 107506 i
WELDASC Y asvmoeTo 1| Welocitye 2 |50 91
WELDASC | ASVROSTD N2 | Veociy 21000 30
WELDASC Y azsm0aTo Vi | welneny 3 |- a0
WELD T30 N ALL T30 USERIDE 105506 i
WELDTE0 Y ruasvEy - Ho |- 107306 g =
WELDTE0 Y r23350EW V1 | Peetil Reponce Time |2 | 2500 00:00:02.00 |92
WELD TS0 V| r233508W N2 | pervanile Reqponce Tome (3| 300000 00:00:20.00 |95
WELD T30 Y rz3spEY Y3 | welocr 5 |- 1
WELDTE0 V| razzsmwp - Mo | Production TS0 Helpers 971106 VT
WELDTE0 V| 12335000 1 | Percentile Responce Tome (2 | 2000 00:00:01.00 |99
WELD T30 V| 1z335m0p 2 | Percertile Response Thme (3| 10000 00:00:03.00 |99 |
WELD T30 V| rzz35mLp 3 | Percetile Response Time (3| 70000 00:00:05.00 | 99
WELDTE0 V| raz3smwp 4| Welocitye 5 10
WELDTE0 Y 12335008 b Mo | Operstors TS0 Service Clase 272516 HH.
WELD T30 V| rzz3s0ms N1 | Perceile Response Time |3 | 10000 00:00:02.00 |95
WELD T30 Y rz3s0ms V2 | Pervatile Response Tame |3 | 300000 00:00:15.00 | 95
WELDTSO V| T23350BS 3 | Velociy 4 |- 10
WELD TS0 Y ra3350R0 - Mo | MISC Production T30 272516 NN
WELD T30 Y rzaseR0 1 |Percentile Response Time (2 | 2300 00:00:02.00 |95 =
Nn| | Cescription Elernent
1 & Velocty goals grester 90 have been specified. Workload "AKLDASC" f Service Class "A3W305TD" =]
2 & Mo capakilty to limit non-swappable jobs from consuming excessive resources in policy DEF ... Service Policy "DEFALLT" (=
3 A& Mo capskilty to limit non-swappablz jobs from consuming excessive resources in policy SD9... Service Policy "SD393045" |
4 & Clagsification rules in subsystem JES are specified as storage critical. Classification "JES" -
Information | Problems

fEIEment specification may not be correct.
—_—— =
iy Start ’ [ m @

Figure 7

The Automatic error check feature is a kind of WLM health check and can be very useful.
Whatever view you are using you have the possibility to click on Problems (at the left bottom of
the screen) and access a list showing errors, warnings and informational messages WSE found in
your Service Definition.

ND| | Diescription Element
1 & Welocity goals grester 90 have heen specified. Workload "TS0" § Service Class "TSOHIGH"
2 & hocapahility to limit non-swappahble jobs from consuming excessive resources in policy Wl | Service Policy "WLkPOLO0"
3 & Defsult service class and report class are not defined for subsystem CICS. Classification "CICs"
4 & Default zervice class and report class are not defined for subsystem DB2. Clagsification "DE2"
5 A& Default service clazs and report class are not defined for subsyatem IMS, Classification "MS"
6 & SPM rules are not defined in the STC classification rules. Clazsification "STC"
Information | Problems |

Figure 8
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Additional useful functionality provided are:

» Table columns can be moved as needed

» Table rows can be sorted as needed

» Rearranged tables can be edited

» Search function for arbitrary text within tables

S Uploading WLM definitions to z/OS

After editing WLM settings you have to send the updated Service Definition to Z/OS.

Similarly to the Download you just have to use the Transfer option in the File menu and select the
appropriate FTP Connection.

Again when you click the Upload button a FTP communication is established between the
workstation and the selected host and a job is submitted on z/OS".

As soon as the job ends all the produced sysout are sent back and analyzed by WSE. If any error
has occurred you’ll get a window including the “SPOOLFILE’ list.

Unfortunately we discovered an unexpected behavior in this phase. We tried to upload the Service
Definition on the same PDS file we normally use to save WLM definitions in z/OS.
WSE realized the dataset already existed and sent the message in Figure 9.

upload Error x|

Cr ] There is a dataset with the same name on the host.
Do you want to overwrite it?

Yes No

Figure 9

We answered yes and apparently everything ended correctly. We accessed the new definitions
using the classic WLM interface and installed and activated them on the system.

On the next day we discovered the WLM PDS file had been deleted by our “public” disks
cleaning job.

What had happened was that WSE instead of overwriting the PDS file, deleted it and created a
new one, unfortunately on a “public” disk.

6 Conclusion

IBM made available a workstation-based tool named “WLM Service Definition Editor” which
maintains WLM service definitions using a much more user friendly interface. Using this tool you
can get many advantages in terms of visibility and manageability of WLM definitions especially
in complex, multi sysplex environments.

We tested WSE and found many benefits but also an unexpected behavior in the uploading of a
WLM Service Definition to z/OS that, in some situation, could become a critical issue.

3 This time however you are converting from XML to ISPF format while in Download you do the opposite.
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